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1 Introduction 
1.1 Purpose of Document 
Target Audience: End users of NHSmail 2 who require assistance to configure the 
system for use on a desktop application 
 
This document contains step-by-step instructions for setting up Outlook 2007, Outlook 2010, 
Outlook 2013 and Outlook 2016. 
 
The NHSmail 2 helpdesk can assist users with queries about supported email programmes 
which NHSmail 2 has been designed to work with (Outlook 2007, 2010, 2013 and 2016). The 
helpdesk is unable to offer assistance with unsupported email programmes (all apart from 
those listed above), so you should refer to your local IT helpdesk. 
 
Background information for Network Administrators: all NHSmail 2 traffic is encrypted 
between the client and the NHSmail 2 service including Outlook which uses Outlook 
Anywhere (RPC over HTTP) or ‘MAPI over HTTP’ protocols both using port 443.  
 

2 Connection methods 
The recommended method of connecting your email programme to the NHSmail 2 service is 
to use Microsoft Outlook 2013 SP1 using protocol MAPI over HTTP. Legacy clients Outlook 
2007 SP3, Outlook 2010 SP1 and Outlook 2013 RTM will connect via Outlook Anywhere. 
 
‘MAPI over HTTP’ and ‘Outlook Anywhere’ enable users to access NHSmail 2 securely and 
efficiently, even if they are working outside a/their health and social care organisation. 
 
‘MAPI over HTTP’ and ‘Outlook Anywhere’ also enable users to make full use of key 
NHSmail 2 features such as accessing shared folders, shared calendars and the NHS 
Directory. 
 
Note: LOAs will have the option to disable ‘Outlook Anywhere’ for users via the Portal. If 
‘Outlook Anywhere’ is disabled, users will not be able to use Outlook on their personal laptop 
computers.  
 
Outlook Anywhere supported versions: 

• Outlook 2013. 
• Outlook 2010 SP1 with November 2012 Cumulative Update (available from 

http://support.microsoft.com/kb/2687623). 
• Outlook 2007 SP3 with November 2012 Cumulative Update (available from 

http://support.microsoft.com/kb/2687404). 
• Entourage 2008 for Mac, Web Services Edition. 
• Outlook for Mac 2011. 

 
Note: Microsoft recommends using the latest available updates for Outlook 2016, Outlook 
2013, Outlook 2010 and Outlook 2007. 
 
MAPI over HTTP supported versions: 

http://support.microsoft.com/kb/2687623
http://support.microsoft.com/kb/2687404
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• Outlook 2016. 
• Outlook 2013 SP1. 
• Outlook 2010 SP2 and updates KB2956191 and KB2965295 (April 14, 2015). 

 
If you do not meet these requirements for ‘MAPI over HTTP’ & ‘Outlook Anywhere’ and you 
want to use an email programme, you will have to: 
 

• Use an IMAP or POP connection over an N3 connection (which limits the features of 
NHSmail 2 such as Out of Office messages, shared folders, shared calendars, the 
NHS Directory and more). 

• Upgrade your version of Windows/Outlook. Contact your local helpdesk for more 
details on how to upgrade. 
 

Otherwise, you can use the NHSmail 2 service through the web portal at www.nhs.net. 
 

3 Checking your version of Windows 
In order to use ‘MAPI over HTTP’ and ‘Outlook Anywhere’ you need to be using Windows 7, 
Windows 8, Windows 8.1 or Windows 10. 
 
To check the version of Windows that is running on your PC, follow the link below from the 
PC you wish to check: 
http://windows.microsoft.com/en-gb/windows/which-operating-system  
 
This Microsoft site will automatically check which version of Windows is running on your PC, 
returning the following message: ‘This PC is running: Windows (7/8/10)’. 
 

4 Checking your version of Outlook 
In order to use Outlook Anywhere you need Outlook 2007 or a later version of Outlook. The 
exact method of checking which version of Outlook you are using depends upon the version 
itself.  
 

4.1 Checking Outlook 2007 version 
Follow the steps below to check your Outlook version on Outlook 2007: 
 

1. Once you have logged into Outlook, click on the Help menu 
2. Select About Microsoft Office Outlook 

 

http://www.nhs.net/
http://windows.microsoft.com/en-gb/windows/which-operating-system
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The version of Outlook that you are using is displayed at the top of the About Microsoft 
Office Outlook window.  
 
Important: If you are using Outlook 2007, the version must be 12.0.6665.5003 or later. If 
your version is in between 12.0.4518.1014 – 12.0.6665.5003 you may not be able to use 
your NHSmail 2 email account. Screenshots from an unsupported and supported version of 
Outlook 2007 are shown below.  

Screenshot from unsupported version 
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Screenshot from supported version 
 

Once you have established that you are using Outlook 2007, go to the Configuring Outlook 
2007 section of this document to set up your NHSmail 2 account. 

 

4.2 Checking Outlook 2010 version 
Follow the steps below to check your Outlook version on Outlook 2010: 
 

1. Once you have logged into Outlook, click on the File menu 
2. Select Help 

 
The version of Outlook that you are using is displayed on the right of the Help window.  
 
Important: You need to use version 14.0.6126.5003 or later. If not, you may not be able to 
use your NHSmail 2 email account.  
 
Once you have established that you are using Outlook 2010, go to the Configuring Outlook 
2010 section of this document to set up your NHSmail 2 account. 
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4.3 Checking Outlook 2013 version 
Follow the steps below to check your Outlook version on Outlook 2013: 
 

1. Once you have logged into Outlook, click on the Office Account menu 
2. Select About Outlook 
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The version of Outlook that you are using is displayed at the top of the About Microsoft 
Office Outlook window.  

   
Once you have established that you are using Outlook 2013, go to the Configuring Outlook 
2013 section of this document to set up your NHSmail 2 account. 

 

4.4 Checking Outlook 2016 version 
Follow the steps below to check your Outlook version on Outlook 2016: 
 

1. Once you have logged into Outlook, click on the Office Account menu 
2. Select About Outlook 
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The version of Outlook that you are using is displayed at the top of the About Microsoft 
Office Outlook window.  
   

 
Once you have established that you are using Outlook 2016, go to the Configuring Outlook 
2016 section of this document to set up your NHSmail 2 account. 

 

5 Configuring Outlook 2007 
If you are using Outlook 2007 you should make use of Outlook's 'Autodiscover' feature. This 
means that during the setup of your new NHSmail 2 profile you only need to enter your 
name, NHSmail 2 email address and your NHSmail 2 password. Outlook will then 
automatically create your new profile. 
 
Note: after configuring NHSmail 2 using Autodiscover, NHSmail 2 will be opened by default 
each time Outlook starts. This means that any email accounts that were set up on the 
computer before Autodiscover was run (i.e. local nhs.uk accounts) will not be visible (the 
data is not “lost” it is just not visible.) 
 
Your local IT helpdesk can provide you with further guidance about this functionality. 
 

5.1 Using Autodiscover to configure Outlook 2007 
Follow the instructions below to use Autodiscover to configure your NHSmail 2 account using 
Outlook 2007. 
 

1. Click on Start and select Control Panel 
2. Click on User Accounts  
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3. Click on Mail   

4. Click on Show Profiles… in the Mail Setup – Outlook window 
5. Click on Add… in the Mail window: 

 
6. Enter your email address in the New Profile Window and then select OK 

 
In the screen below you will need to populate the fields as follows: 
 

• Type your name in the Your Name field 
• Type your email address in the E-mail Address field 
• Leave the Password field blank 
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• Leave the Retype Password field blank 
• Click Next 
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7. Outlook will begin to search for the configuration settings. After a few seconds a 
dialogue window will open 

• Type your NHSmail 2 email address in the Email Address field 
• Type your NHSmail 2 password in the Password field 

 
8. Click on OK 
9. Once Outlook has finished detecting the configuration settings, select Manually 

configure server settings in the bottom left of the Add New Email Account window 
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10. Click on Next 
11. Click on More Settings and then view the Connection tab 
12. Click on Exchange Proxy Settings  



Desktop Configuration Guide for NHSmail 2 V1.0 

 

 
 
Page 14 of 40  Copyright © 2015 Health and Social Care Information Centre 

 
 

13. Tick the option for On fast networks, connect using HTTP first, then connect 
using TCP/IP  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Click on OK, then OK and then Finish 
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15. In the Mail window, select Always use this profile and ensure that the correct profile 
is displayed in the drop-down menu 
 

 
 

16. Click on OK 
 

5.2 Connecting to NHSmail 2 (logging in to Outlook) 
When you open Outlook using your NHSmail 2 profile, a dialogue window will prompt you to 
enter your user name and password.  
 

• Enter your NHSmail 2 email address in the User name field. 
• Enter your NHSmail 2 password in the Password field. 
• Click OK. 
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5.3 Remember my password 
Outlook will not remember your NHSmail 2 password by default. If you want your password 
to be entered automatically at log in, select the Remember my password tick box. If you do 
not do this, you will need to enter your password each time you open Outlook and connect to 
NHSmail 2. 
 
 

6 Configuring Outlook 2010 
If you are using Outlook 2010 you should make use of the Outlook 'Autodiscover' feature. 
This means that during the setup of your new NHSmail 2 profile you only need to enter your 
name and your NHSmail 2 email address. Outlook will then automatically create your new 
profile. 
 

6.1 Using Autodiscover to configure Outlook 2010 
Follow the instructions below to use Autodiscover to configure your NHSmail 2 account using 
Outlook 2010. 
 

1. Click on Start and select Control Panel 
2. Click on User Accounts 

 
3. Click on Mail   
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4. Click on Show Profiles… in the Mail Setup – Outlook Window 
5. Click on Add… in the Mail window: 

 

 
 

6. Enter your email address in the New Profile Window and then select OK 

 
 

 
In the screen below you will need to populate the fields as follows: 
 

• Enter your name in the Your Name field 
• Enter your email address in the E-mail Address field 
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• Leave the Password field blank 
• Leave the Retype Password field blank 
• Click Next 

 

 
You will then be asked to enter your NHSmail 2 password.  
 
Important: do not tick the ‘Remember my credentials’ box.  
 

7. Click OK. 
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Your NHSmail 2 account is now configured to work with Outlook 2010. Click Finish. 

 
8. Open Outlook  
9. Click File, Info, then Account Settings 

 
 
 

` 
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10. Double click your account name in the E-mail tab 
 

 
11. Click the More Settings button 

 

 
12. Select the Connection tab and then the Exchange Proxy Settings… button 
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13. Tick the option for On fast networks, connect using HTTP first, then connect 
using TCP/IP  

 



Desktop Configuration Guide for NHSmail 2 V1.0 

 

 
 
Page 22 of 40  Copyright © 2015 Health and Social Care Information Centre 

14. Click OK, then OK again, Next, Finish and Close to return to the main Outlook 
screen 

 

6.2 Connecting to NHSmail 2 (logging in to Outlook) 
When you open Outlook using your NHSmail 2 profile, you will be prompted to enter your 
user name and password.  

• Type your NHSmail 2 email address in the User name field 
• Type your NHSmail 2 password in the Password field 
• Click OK 

 

6.3 Remember my password 
Outlook will not remember your NHSmail 2 password by default. If you want Outlook to enter 
your password automatically, select the Remember my password tick box. If you do not do 
this, you will need to enter your password each time you open Outlook and connect to 
NHSmail 2. 
 

6.4 Add another account to your NHSmail 2 account 
To add another account to your NHSmail 2 account: 
 

1. Open Outlook 2010 and click on File 
2. Select Account Settings, then Account Settings again 
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3. Click on New…  
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In the screen below you will need to complete the fields as follows: 
 

• Enter your name in the Your Name field 
• Enter your email address in the E-mail Address field 
• Leave the Password field blank 
• Leave the Retype Password field blank 
• Click Next 

 

 
A message will ask you to restart Outlook for these changes to take effect. 
 

 
 
The next time you open/log into Outlook, you will be prompted to enter the password for the 
new account just added (there may be a second pop-up if the NHSmail 2 account password 
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is not saved). If the passwords for both accounts are saved there will be no password 
prompts. 
 

 
 

 

7 Configuring Outlook 2013 
If you are using Outlook 2013 you should use the Outlook 'Autodiscover' feature. This means 
that during the setup of your new NHSmail 2 profile you only need to enter your name and 
your NHSmail 2 email address. Outlook will then automatically create your new profile. 
 

7.1 Using Autodiscover to configure Outlook 2013 
Follow the instructions below to use Autodiscover to configure your NHSmail 2 account using 
Outlook 2010. 
 

1. Click on Start and select Control Panel 
2. Click on User Accounts  

 
3. Click on Mail   
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4. Click on Show Profiles… 

 
 

5. Click on Add… in the Mail window 

 
 

 
6. Enter your email address in the New Profile Window and then select OK 
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In the screen below you will need to populate the fields as follows: 
 

• Enter your name in the Your Name field 
• Enter your email address in the E-mail Address field 
• Leave the Password field blank 
• Leave the Retype Password field blank 
• Click Next 

 
 

You will be asked to enter your NHSmail 2 password.  
Important: do not tick the ‘Remember my credentials’ box. Click OK. 
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Your NHSmail 2 account is now configured to work with Outlook 2013.  
Click Finish. 
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7.2 Connecting to NHSmail 2 (logging in to Outlook) 
When you open Outlook using your NHSmail 2 profile, you will be prompted to enter your 
user name and password.  
 

• Enter your NHSmail 2 email address in the User name field 
• Enter your NHSmail 2 password in the Password field 
• Click on OK 

 

7.3 Remember my password 
Outlook will not remember your NHSmail 2 password by default. Select the Remember my 
password tick box so that you do not need to enter it each time you log on. If you do not do 
this, you will need to enter your password each time you open Outlook and attempt to 
connect to NHSmail 2. 
 

7.4 Add another account to your NHSmail 2 account 
To add another account to your NHSmail 2 account: 
 

1. Open Outlook 2013 and click the File menu 
2. Click Account Settings, then select Account Settings again from the drop down 

menu 
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3. Click on New…  

 
 
In the screen below you will need to populate the fields as follows: 
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• Type your name in the Your Name field 
• Type your email address in the E-mail Address field 
• Leave the Password field blank 
• Leave the Retype Password field blank 
• Click Next 
 

 
 
Your new account is now configured to work with Outlook 2013. Click Finish. 
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You will be prompted to restart Outlook for these changes to take effect. 
 

 
The next time you log onto Outlook, enter the password for the new account you just added 
(there may be a second pop-up if the NHSmail 2 account password is not saved). 
If the passwords for both accounts are saved there will be no password prompts. You can 
also decide whether to allow Outlook to remember your credentials.  
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8 Configuring Outlook 2016 
If you are using Outlook 2016 you should use the Outlook 'Autodiscover' feature. This means 
that during the setup of your new NHSmail 2 profile you only need to enter your name and 
your NHSmail 2 email address. Outlook will then automatically create your new profile. 
 

8.1 Using Autodiscover to configure Outlook 2016 
Follow the instructions below to use Autodiscover to configure your NHSmail 2 account using 
Outlook 2016. 
 

1. Click on Start and select Control Panel 
2. Click on User Accounts 

 
3. Click on Mail   

 
 

 
 
 

4. Click on Show Profiles… 
 

 
 

5. Click on Add… in the Mail window 
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6. Enter your email address in the New Profile Window and then select OK 
 

 
 
In the screen below you will need to populate the fields as follows: 
 

• Enter your name in the Your Name field 
• Enter your email address in the E-mail Address field 
• Leave the Password field blank 
• Leave the Retype Password field blank 
• Click Next 
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You will be asked to enter your NHSmail 2 password.  
Important: do not tick the ‘Remember my credentials’ box. Click OK. 
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Your NHSmail 2 account is now configured to work with Outlook 2016.  
Click Finish. 

 
 

8.2 Connecting to NHSmail 2 (logging in to Outlook) 
When you open Outlook using your NHSmail 2 profile, you will be prompted to enter your 
user name and password.  
 

• Enter your NHSmail 2 password in the Password field 
• Click on OK 

 



Desktop Configuration Guide for NHSmail 2 V1.0 

 

 
 
Page 37 of 40  Copyright © 2015 Health and Social Care Information Centre 

 
 

8.3 Remember my password 
Outlook will not remember your NHSmail 2 password by default. Select the Remember my 
password tick box so that you do not need to enter it each time you log on. If you do not do 
this, you will need to enter your password each time you open Outlook and attempt to 
connect to NHSmail 2. 
 

8.4 Add another account to your NHSmail 2 account 
To add another account to your NHSmail 2 account: 
 

1. Open Outlook and click on the File menu 
2. Click Account Settings and select Account Settings again from the drop down 

menu 
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3. Click New… 
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In the screen below you will need to populate the fields as follows: 
 

• Type your name in the Your Name field 
• Type your email address in the E-mail Address field 
• Leave the Password field blank 
• Leave the Retype Password field blank 
• Click Next 
 

 
 
Your NHSmail 2 account is now configured to work with Outlook 2013. Click Finish. 
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You will be prompted to restart Outlook for these changes to take effect. 
 

 
 
The next time you log onto Outlook, enter the password for the new account you just added 
(there may be a second pop-up if the NHSmail 2 account password is not saved). If the 
passwords for both accounts are saved there will be no password prompts. You can also 
decide whether to allow Outlook to remember your credentials. 
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